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Links Discussed Throughout this Video:
• Watts Digital Home Page:
https://www.wattsdigital.com/Home.html
• Free Useful Downloads:
https://www.wattsdigital.com/freecolorwheelstuff.html
• Join my mailing list to receive my Photoshop “Quick Tip” Newsletter:
Click Here to Join
• Photoshop Meetups:
https://www.wattsdigital.com/San_Diego_Meetups.html
• Blogpost: What is a Master File, and why do I need one?
https://blog.main.wattsdigital.com/?p=1853
• Blogpost: Photoshop vs Lightroom? Wrong Question!
https://blog.main.wattsdigital.com/?p=1840
• Blogpost: The Philosophy of RAW:
https://blog.main.wattsdigital.com/?p=2215
• Blogpost: Layer Mask Concepts & Basics, Part 1:
https://blog.main.wattsdigital.com/?p=2283
• Blog Home Page:
https://blog.main.wattsdigital.com
• “Not Just Another Photoshop Book”:
http://www.amazon.com/dp/B07HNLS1Q2
• My YouTube Channel:
https://www.youtube.com/user/wattsdigitalvideos
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RAW Fundamentals for Photoshop

Ever wonder why that sunset that you shot is flat, lifeless, and “looks digital” because of artifacts? Why is it
that you can’t get detail in the highlights of that waterfall? Did you make a “boo-boo”, and over-expose that
image of your Mother-in-law?
You should be shooting in Camera RAW for your important work -- the results are worth it! The more
digital information you’re able to capture when you shoot, the more information you have to effectively
create your image.
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The Master File and Workflow

If a picture is truly worth a thousand words, then here’s an overall visual representation of the Workflow
Chart that I recommend you adopt (from my book) – notice that your Workflow centers on creating a Master
File.

Creating a Master File is NOT for every image: it’s for those images that you want to spend time with,
doing all that’s necessary to make your image “pretty”. Here’s where you pour your artistic “blood, sweat
and tears” into your image.
What is a “Master File”? It’s a 16-Bit, un-flattened, un-sharpened, un-cropped, un-resized file designated
as such in its file name.
Why create a Master File?
•

It’s Multi-purpose: Use it to create separate files for a specific print size or printer, for the Web, for
magazine output, etc. and you’ll stay consistent between those files.

•

It’s easily correctable: for color, contrast, cropping, enhancements, etc. non-destructively (loss of
digital information).

•

Sharpening is applied according to your print size: Let’s say that your Master File is created from
a RAW file – It might be around 11”x16.5” at 300 ppi – If you sharpen for this size and reduce the
file to prep for a 4x6 print, it will be over-sharpened.
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What is RAW, and why do I need it?

•

A Camera RAW file contains unprocessed, uncompressed 16-bit data from your digital camera.
It’s just information, but lots of it. It isn’t really a file “format”, like JPG or TIFF. It also doesn’t have
a Color Space (discussed in another seminar).

•

You can’t open a RAW file directly in Photoshop: You must first work with it in The Adobe Camera
RAW Plug-in (ACR) before “sending” it to Photoshop. By the way, ACR is a separate program, but
included with (and “linked to”) Photoshop.

•

You should be shooting in Camera RAW for your important work -- the results are worth it!
The more information you are able to capture when you shoot, the more information you have to
effectively create your image.

•

If your Camera has the option of shooting “RAW” + JPG”, then you should do so – It takes up
little in memory, and gives you a quick “look-see” image that’s been “processed” for contrast, color,
etc (albeit by a computer chip!). Oh, and I frequently hear folks say “My JPG looks better!” - - read
on, and you’ll never believe that again!

•

Tonal Compression: This was discussed in Chapter 1, but this is a great time to review - This is
the inevitable reduction /degradation of the original scene from your eyes to the print. It’s pure
physics - the range of colors reproduced shrinks throughout the process. Let’s say, for example,
that our eyes see 100 shades of red. The camera, shot in RAW, may see 70 shades. Then
Photoshop may see 50 shades of red, and the printer may only print 30 shades of the original 100
shades available.
So, how can you minimize some of the effects of tonal compression? Three things:
1) - Shoot in RAW (or scan in 16 bit)
2) - Use a proper Color Working Space in Photoshop (discussed in another seminar)
3) - Have your Color Management “house” in order
(discussed in the “Color Management” seminar)
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A RAW file is different from a JPEG in 2 major respects:
1) There’s much more information in RAW capture (16 bit vs. JPG’s 8 bit) - a good portion
of it may not even be in the “visible spectrum”.
2) There’s automatic “file compression & processing” built into the creation of a JPG,
whether you want it or not.

•

16 bit vs. 8 bit:
More information is a very good thing in photographic capture. Bit Depth is like the Earthquake
Richter Scale: it’s logarithmic - a 6.0 earthquake is twice as powerful as a 5.0 earthquake, not
just 20% more powerful, as the numbers on the scale would seem to indicate. Likewise, a 16bit file is NOT twice as much information as an 8-bit file: it’s hundreds of times more
information.
(JPG) 8 Bit: 255 values of each color x 3 (RGB) = 17.7 Million combinations of RGB
(RAW) 16 Bit: 65,000+ values of each color x 3 (RGB) = 281 Trillion combinations of RGB

•

What is an .xmp file?
It’s a separate (“sidecar”), tiny, glorified “text” file that contains “metadata” – you never need to
directly open it.
Think of it as the “instructions” for all of that RAW information (which is never directly “changed”).
It’s generated as soon as you make any “modifications” to your RAW file, and saves those
“instructions” in the same folder as your RAW file.
A few things to remember:
1) - If you back up your RAW file, back up your .xmp file, too; it’s in the same
folder/location as your RAW file.
2) - If you’re working in “Bridge” and can’t see the .xmp file, simply go to “View” Menu ->
“Show Hidden Files”.
3) - If you want to start over with your original “as shot” RAW capture, simply “trash” the
.xmp file.
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Adobe Camera RAW Plug-in (ACR) to Photoshop Workflow

Adobe Camera RAW plug-in (ACR) to Photoshop - what should be done in each
program?
•

Generally, I’d suggest that you make as many global Hue, Saturation and Brightness corrections
as you can in the Adobe Camera RAW plug-in (ACR), following the “Goals” shown below.

•

Further, I’d also suggest leaving all contrast adjustments, localized corrections of any kind, “finetuning”, cropping and sharpening to Photoshop - you can then take advantage of the power of
adjustment layers and layer masks, “fine-tuning”, cloning, cropping, sharpening, and much more.

•

While it’s true that you’ll spend a bit more time in your overall Photoshop Workflow by shooting in
RAW, it’s really not that much more - you’ll probably spend less time in Photoshop by spending a
few more minutes in ACR first – and the results are worth it!

…so, the “Goals” are to bring your final RAW image into Photoshop:
• Slightly Over-Saturated - - It’s easier to de-saturate in Photoshop …
• Slightly Low or “Flat” in Contrast - - It’s easier to increase your contrast in Photoshop …
• Slightly Under-Exposed - - It’s easier to lighten in Photoshop …
• Best Overall Color Balance - - You can “fine-tune” individual areas in Photoshop …

•

Why these “Goals”, you ask? Following these 4 “Goals” will bring LOTS of information from
your digital capture into the “visible spectrum” (and hence your Master File in Photoshop).

•

Further, it provides “headroom”, or a “margin of error” – it’s always better to have more
information than not enough, and information is king in post-processing.

Keep in mind that by using these “Goals” your aim is NOT to make a perfect image in ACR (which is
what most people try to do, including Lightroom users in the “Develop” Module - and you simply can’t)
- - - by using these “Goals”, you’ll take advantage of the strengths of both ACR and Photoshop in
your overall workflow to end up with your final desired “killer” image (via your Master File).

•

What are those strengths? ACR is designed to get as much digital information as you can out
of your digital capture, and Photoshop is the industry standard in using that information for the
best possible (and most flexible) results.
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Points to Remember:
•

There are actually quite a few advanced tools in the ACR Plug-in. However, both in Workflow
and the spirit of K.I.S.S. (Keep It Super Simple), you should not be using the more advanced
functions - it’s quite possible that you, like me, will never use them!.

•

You should strike a balance of time spent with your file in both ACR and Photoshop, using the
strengths of each program. Typically, I’ll spend 25 to 30% of my “file” time in ACR, with the
balance in Photoshop.

•

The Histogram shows those pixels brought into the "visible spectrum" from your original "bucket"
of RAW Capture.

•

I never use any of the various tools and brushes in ACR – 3 reasons:
1) There’s not a true “History” Panel to fall back on (like in Photoshop) if I don’t like what
I see.
2) There are no “Layers” in ACR.
3) Photoshop does a much better job of doing what most of these “gee-whiz” functions in
ACR do.

•

By bringing your file from ACR into Photoshop as suggested, your
histogram in Photoshop should reflect it (depending on the
subject matter, of course) with a bias of extra pixels to the left-hand
side, similar to the Levels dialog box shown - slightly underexposed,
with plenty of “headroom” (room for adjustment), particularly in the
highlights.

•

Once you press the “Open Image” button on the bottom right of the
ACR Workspace, your file opens in Photoshop. You’ll notice 3
things will happen:
1) ACR Closes
2) Your file opens in Photoshop
3) An .xmp file is generated and saved

•

Now you can task your Master file (discussed earlier) for many uses – You can crop, sharpen
and convert to 8-bit for printing on your inkjet printer or through a custom lab; you can reduce the
size and PPI to save as a JPG for the web, and so on.

•

Notice the Filename and File Extension’s evolution:
1) When you bring the file into Photoshop from ACR, the file
extension (.NEF & .CR2 or similar) leads you to believe it’s still a
RAW file (for the propeller-heads amongst us, it’s not really – it’s
a 16-bit hybrid TIFF).
2) Next, you save your image as a Master File (with the “_M” at
the end of the filename) – your image shows up with the “.TIFF”
or “PSD” extension, depending on what you select.
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Using Camera RAW Filter for “Non-RAW” Files in Photoshop

Using Camera RAW Filter for “Non-RAW” files in Photoshop
You’ll notice from the Workflow Chart in my book that I run everything (RAW and non-RAW files) through
Adobe Camera RAW for maximum results – but opening a non-RAW file in the ACR plug-in can be
problematic.
Not to be confused with the Adobe Camera RAW (ACR) “plug-in” (which is technically a separate program),
there is a “filter” in Photoshop CC that gives you access to some of the better features of ACR – It’s called
the Camera RAW Filter, and works on your “non-RAW” files such as JPG, TIF, and so on.
I incorporate this Filter into my regular “non-RAW file” workflow (particularly for “problem” files), and I’ve
drastically improved overall quality – plus, I’ve frequently reduced the total amount of time I spend working
on an image in Photoshop.
Here’s how to do it:
1) Use this Filter after you’ve opened your “non-RAW” file in Photoshop (JPG, TIFF, PSD, etc)
2) Create a Background Copy first – to do this, with your Background Layer active, go to “Layer” ->
“Duplicate Layer …”
3) Make your Background Copy active by clicking on it once, then go to the “Filter” menu, then
choose -> “Camera RAW Filter …” - now follow the steps in the Workflow Chart on page F.
Minor Disadvantages
•

It’s limited to the bit depth of the original non-RAW file – If you open a JPG (8-bit), it will stay 8-bit.

•

Lens corrections is unavailable – there are no lens profiles like in ACR.

•

Unlike the ACR plug-in (which generates an .xmp file), the adjustments you make in Camera
RAW Filter are not saved - that’s why you use it with a background copy so it’s saved separately
within your Master File.

•

If you start with a JPG, you’ll need to save your final version as a TIFF or PSD, as JPG’s cannot
be saved with Layers.
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The ACR Workspace
Accessing the ACR Plug-In:
The easiest way to access the Adobe Camera RAW (ACR) Plug-in is to go to the “File” menu  “Open…”
in Photoshop – Choose a RAW file, and the ACR Plug-in Workspace will automatically open.

Set your Preferences:
1. In the "Preferences" menu, choose "Apply sharpening to preview images only". You should
sharpen only in Photoshop (except for the Clarity slider in ACR, discussed later), not by using the
sharpening in ACR – The algorithm for sharpening and the techniques used are much better in
Photoshop. You’ll only have to set this preference once.
2. In the "Workflow Options" Menu, choose:
•
•
•

•

"Adobe RGB (1998)" for "Space"
“16-Bits/Channel" for "Depth"
For "Image Sizing", uncheck "Resize to Fit" -- This will give you a file equal to the native
size of your camera sensor: It’s better to use Photoshop, not the RAW plug-in, to enlarge
your image to the desired size, as the sharpening algorithm in Photoshop is so much
better.
"300 pixels/inch" for "Resolution".

Unless you have RAW files from more than one camera, you’ll only have to set this once.
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ACR Workspace features:
Let's look at some features of the Workspace before working with the adjustments. This list is far from
complete -- In the spirit of K.I.S.S. (Keep It Super Simple), stick to the basics, master those, and grow into
the other functions of ACR.
•

As shown on the previous page, you’ll notice the "Preview” Toggle -- use this for before-and-after
scenarios. This only previews the tab that you’re currently using, not the overall image.

•

You can check for Clipping by using the "Clipping" Toggles (explained in the next section)

•

All of the most popular Speed Keys and Navigation Tools that are available in Photoshop are
also available in ACR.

•

When all of your adjustments are completed in ACR, click on the "Open Image" button. As
mentioned earlier, 3 things happen when you do:
1) ACR closes,
2) your image opens in Photoshop,
3) an .xmp file is generated (and saved in the same folder as your RAW file).

RAW Overall Workflow Checklist:
1) Open your RAW file in ACR (or your “non-RAW” file in Camera RAW Filter)
2) Adjust the “Lens Corrections” Tab (Except Camera RAW filter)
2) Adjust the “Basic” Tab – Exposure and Contrast first, then Color
3) Adjust the “HSL” Tab
4) If necessary, adjust the “Detail” Tab for Noise Reduction
5) Open in Photoshop
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ACR in Action
A refresher from an earlier section: The “Goal” is to bring your final RAW image into Photoshop:
• Slightly Over-Saturated - - It’s easier to de-saturate in Photoshop …
• Slightly Low or “Flat” in Contrast - - It’s easier to increase your contrast in Photoshop …
• Slightly Under-Exposed - - It’s easier to lighten in Photoshop …
• Best Overall Color Balance - - You can “fine-tune” individual areas in Photoshop …

How to Check for Clipping
Clipping is “the unwanted elimination and usage of
digital information”. Because a RAW file has so much
information, it needs to be optimized. As you do so,
you’ll be using the Clipping Warnings in ACR, similar to
the ones in Levels (discussed in another seminar).
By making the proper adjustments in ACR with the
Clipping Warnings turned on, you’ll take advantage of
the full range of tonal values available to you in your
image - you can set the brightest parts of your image as
close to pure white as possible and the darkest parts as
close to pure black as possible, without “clipping” pixels.
•

Toggle the Clipping Warnings on and off a few ways:
o

Turn the "Clipping" Toggles on by clicking on the square boxes with the triangles in it in the
upper corners of the histogram.

o

You can also hold down the "Option" key in Mac (" Alt" key in Windows) while adjusting the
appropriate sliders in the “Exposure / Contrast” group (discussed shortly)

o

The square box on the left will turn on the Shadow Clipping Warning, and the square box on
the right will turn on the Highlight Clipping Warning.

o

You’ll know that the clipping toggles are active when the small box has a black pinstripe
around it.

To Correct for Clipping: With the Clipping Warnings activated, move the appropriate sliders in the
“Exposure / Contrast” group (discussed shortly) until the clipping masks disappear (or as close as
you can, if it’s not possible to completely eliminate clipping).
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How to Check for Clipping (Cont’d)
•

Highlight Clipping is typically shown in red, and Shadow Clipping is typically shown in blue –
very similar to the samples on clipping in Levels.

•

When using the Clipping Warning, it should be used as a critically important guide, but a guide
nonetheless: What your eyes see is still the best judge of how your image should look. It’s possible
that you may sacrifice the “greater good” of the image and live with a small bit of clipping (or control
it with a Layer Mask in Photoshop, discussed in another seminar) – let your eyes decide.

About the Tabs:
There are only 4 Tabs that I use on a regular basis, each described in detail below. For the other Tabs,
Photoshop does a much better job than these functions in ACR, so in the spirit of K.I.S.S. (Keep It Super
Simple), I’d leave them alone (I almost ever use them).

The “Basic” Tab:
The "Basic" Tab is the default Tab when ACR opens. It’s where you'll do the vast majority of your
work in ACR by moving the Adjustment Sliders
•

It’s important to get in the habit of making small adjustments at first, then using the "Preview"
toggle to see your results as you go along.

•

You'll notice that the horizontal line that forms each slider is a visual representation of what that
slider can accomplish, color and density-wise. For example, the "Exposure" sliders' horizontal line
goes from dark to light, the "Tint" sliders' horizontal line goes from green to magenta, and so on.

•

Photoshop has conveniently grouped these adjustment sliders into 4 groups by function:

1) Exposure / Contrast Group
2) Color Balance Group
3) Edge Sharpness Group
3) Color Intensity Group

•

Start by adjusting the “Exposure / Contrast Group” first - - As discussed previously, it‘s
imperative to work on each group in the order shown above: Exposure /Contrast should be
adjusted first, followed by the Color Balance – not the other way around! See the Workflow Chart
in my book.

•

In later versions of ACR, there are 2 new controls at the top of the “Basic” tab: “Treatment” and
“Profile” - in the spirit of K.I.S.S., I strongly recommend you ignore both and leave at their
defaults (“Color” and “Adobe Color”, respectively).
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The “Exposure / Contrast” Group:
o

Auto / Default: It’s been my experience that you get better results with manual adjustments – but
you can use these as a guide. Click on the "Auto" button to see if it improves your image: if not,
simply click on the "Default" button, and continue with the manual adjustments below.

o

Exposure: This affects mostly the mid-tones of your image. Move to the left to darken your image,
and to the right to lighten.

o

Contrast: I rarely use this slider - You’ll get better results by adjusting your final contrast in
Photoshop. I generally leave it at the default setting, or even reduce the values.

o

Highlights: This slider will recover highlights that are washed out. Move the slider to the left to
increase the highlight detail.

o

Shadows: Move the slider to the right to open up shadow detail.

o

Whites: This slider will recover extremely bright details. I use it after using the Highlights slider to
“fine-tune”.

o

Blacks: Move the slider to the left to increase the amount of black in your image. Be careful with
this one --It's easy to block out shadow detail if you use too much of it.

The “Color Balance” Group:
•

White Balance: It’s been my experience that you get better results with manual adjustments – but
you can use these as a guide. These are presets for the "Temperature" and "Tint" sliders,
discussed below. From the drop-down menu, you can choose from a number of presets. This will
also give you an idea of how the Temperature" and "Tint" sliders work and interact. Once you move
any slider, this changes from “As Shot” to “Custom”.

•

Temperature: Move this slider to the right to warm up the color of your image (adds a yellow cast),
and move it to the left to cool your image down (adds a blue cast).

•

Tint: Move the slider to the right to increase the overall magenta bias, and to the left to increase
the overall green bias.

The “Edge Sharpness” Group:
•

Texture: This can make up for the inevitable failure of digital capture challenges with sharpness it also increases Contrast, so be careful! 25 - 50 units are usually more than enough to get the job
done.

•

Clarity & Dehaze: I never use these sliders - both of these are also “edge sharpening” tools, like
Texture. Consider Texture to be a fine adjustment, Clarity to be a medium adjustment, and
Dehaze to be a coarse adjustment. Both of these controls radically increase the contrast, which
defeats one of the “goals” discussed earlier - bringing your RAW file into Photoshop low in contrast.
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The “Basic” Tab (Cont’d):
The “Color Intensity” Group:
•

Vibrance: This is “Saturation on Steroids”, preferred to Saturation below. It’s not unusual for me
to add 30+ units.

•

Saturation: I rarely use this, preferring the Vibrance slider above instead.

The “HSL” Tab:
Use this Tab the same way you would the "Hue / Saturation" Adjustment Layer in Photoshop (discussed in
another seminar)

The “Lens Corrections” Tab:
Under the ”Profile” sub-tab, check “Remove Chromatic Aberration” and “Enable Profile Corrections” – on
newer cameras, the profile for your lens should automatically be chosen - use or not use to taste.

The “Detail” Tab:
Adjust Noise Reduction as necessary – rare for low ISO images, necessary for high ISO images (over
1600+), depending on the camera). Start with low values (10 to 25) using the” Luminance” Slider.

Processing Multiple RAW files
If you open multiple RAW files, a new “section” opens on the left side of your
workspace. You’ll see thumbnails of your RAW files.
•

Clicking on a thumbnail highlights it, making it the “active” image.

•

Once completed with your adjustments, choose the “Select All” button BEFORE
pressing the “Open Image” button

•

If you only select only one image and press the “Open Image” button, that image
opens in Photoshop and closes ACR. Don’t worry about all of your work on the
other images – an .xmp file is generated for each of them.
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The ACR-to-Photoshop Evolution Shown Visually
If a picture is worth a thousand words, then this
series of screengrabs of two different images will
visually show you the evolution from the Original
RAW Capture, to the Optimized Master File in
Photoshop:

This image is the original RAW
capture opened and un-edited in
ACR. See the Workflow Chart,
“Open File in ACR”, in my book.

1

This image is the RAW capture
optimized in ACR, ready to
open in Photoshop See the
Workflow Chart, “Optimize File
in ACR”, in my book.

2

This image is the optimized
Master File in Photoshop, ready
to be purposed for print, web,
etc. See the Workflow Chart,
“Optimize Master File in
Photoshop”, in my book.

3
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This image is the original RAW
capture opened and un-edited in
ACR. See the Workflow Chart,
“Open File in ACR”, in my book.

1

This image is the RAW capture
optimized in ACR, ready to
open in Photoshop See the
Workflow Chart, “Optimize File
in ACR”, in my book.

2

This image is the optimized
Master File in Photoshop, ready
to be purposed for print, web,
etc. See the Workflow Chart,
“Optimize Master File in
Photoshop”, in my book.
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